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1 Introduction 

The TMD2635 evaluation kit comes with everything needed to evaluate the TMD2635 . The device 

features proximity detection using an IR VCSEL in a tiny and thin module. 

1.1 Kit Content 

Figure 1:  

Evaluation Kit Contents 

 

 

No. Item Description 

1 TMD2635 Daughter Card PCB with TMD2635 sensor installed 

2 EVM Controller Board Used to communicate USB to I2C 

3 USB Cable (A to Mini B) Connects EVM controller to PC 

4 Flash Drive Includes application installer and documents 
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1.2 Ordering Information 

 

Ordering Code Description 

TMD2635 EVM TMD2635 Miniature Proximity Sensor Module 
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2 Getting Started 

The software should be installed prior to connecting any hardware to the computer. Follow the 

instructions found in the Quick Start Guide (QSG). This loads the required driver for the USB interface 

and also the device’s graphical user interface (GUI).  

The balance of this document identifies and describes the controls available on the GUI. In 

combination with the TMD2635 datasheet, the QSG and application notes available on the ams 

website, there should be enough information to allow evaluation of the TMD2635 device. 
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3 Hardware Description 

The hardware consists of the EVM Controller, the TMD2635 EVM daughter card, and a USB interface 

cable. The EVM controller board provides power and I2C communication to the daughter card through 

a seven pin connector. When the EVM controller is connected to the PC through USB, a green LED 

on the board flashes once on power up to indicate the system is getting power. 

For schematics, layout and BOM information, please see the documents included with the install 

located in the TMD2635 EVM folder (All Programs -> ams -> TMD2635 EVM  > Documents). 

Figure 2:  

Evaluation Kit Hardware 
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4 Software Description 

The main window (Figure 3) contains the system menus, system level controls, device information and 

logging status. The Prox tab contains settings for the proximity function. The application polls the 

proximity raw data continuously and calculates the prox average and standard deviation values. 

Figure 3:  

Graphical User Interface (GUI) Main Window 

 

 

4.1 Connect Software to Hardware 

On startup, the software automatically connects to the hardware. On successful initialization, the 

software displays a main window, containing controls pertinent to the connected device. If the software 

detects an error, an error window appears. If “Device not found or is unsupported” appears, verify the 

correct daughterboard is properly connected to the EVM controller board. If “Cannot connect to EVM 

board” appears, verify the USB cable is connected. When the EVM controller board is connected to 

the USB, a green LED on the board flashes once on power up to indicate the USB cable is connected 

and providing power to the system. 

If the EVM board is disconnected from the USB bus while the program is running it displays an error 

message and then terminates.  Reconnect the EVM board and restart the program. 
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4.2 System Menus 

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File menu 

provides basic application-level control. The Log menu is used to control the logging function, and the 

Help menu provides version and copyright information for the application. 

4.2.1 File Menu 

The File menu contains the following functions: 

Figure 4:  

File Menu 

 

 

The Reread Registers function forces the program to re-read all of the control registers from the 

device and display them on the screen.  This does not read the output data, because those registers 

are continually read while the program is running. 

Click on the Exit command to close the main window and terminate the application.  Any unsaved log 

data is cleared from memory. The application can also be close by clicking the red “X” in the upper 

right hand corner. 

4.2.2 Log Menu 

The Log menu is used to control the logging function and to save the log data to a file. Log data is 

accumulated in memory until it is discarded or written to a data file. 

Figure 5:  

Log Menu 

 

 

Click Start Logging to start the logging function. Each time the program polls the output information 

from the device, it creates a new log entry showing the raw data values, the values of various control 
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registers, and the values entered by the user into the text fields near the bottom right corner of the 

window. 

Click Stop Logging to stop the logging function. Once logging is stopped, the data can be written to a 

file, or the user can continue collecting additional data by clicking Start Logging again. 

The Log a Single Entry command causes logging to start, collect one single entry, and immediately 

stop again.  This function is not available when logging is already running. 

Click Clear Log to discard any data that has already been collected.  If there is data in memory, which 

has not been saved to disk, this function displays a prompt asking to verify it is OK to discard the data. 

If the log is running when this function is clicked, the log continues running after the existing data is 

discarded. 

Click Save Log to save the collected log data to a csv file.  This stops the logging function, if it is 

active, and displays a file dialog box to specify where to store the logged data.  The default file name 

is described in the Log Status and Control Information section, but the file name may be changed if 

desired. 

4.2.3 Help Menu 

The Help menu contains a single function: About. 

Figure 6:  

Help Menu 

 

 

The About function displays a dialog box (Figure 7) showing the version and copyright information for 

the application and library. Click the OK button to close this window and continue. 
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Figure 7:  

About Window 

 

 

4.3 System Level Controls 

Immediately below the top menu bar there are checkboxes used to control the system level functions 

of the TMD2635 device.  

The Power On checkbox controls the PON function of the TMD2635 . When this box is checked, the 

power is on and the device can operate. When this box is unchecked, the power is off and the device 

does not operate (The control registers can still be written, but the device does not function). 

The Prox Enable checkbox controls the PEN function of the TMD2635. Proximity detection is enabled 

when this box is checked or disabled when unchecked. 

4.4 Automatic Polling 

The application automatically polls the TMD2635 raw Prox data if enabled. The Poll Interval displays 

the time between reads of the device. 

4.5 Device ID Information 

The lower left corner of the window displays the ID number of the EVM Controller board, identifies the 

device being used and displays the ID of the device. 
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4.6 Log Status and Control Information 

The lower right corner of the window contains status information and controls for the logging function: 

Figure 8:  

Logging Status 

 

 

This section contains text boxes that are stored in the log file data and used to build the file name for 

the log file. If the data in these fields are changed, the new values are stored with any new data 

logged. The default log file name is based on these values at the time the log file is written. If nothing 

is entered in these boxes they default to a period (“.”). 

Sample default file name: 

TMD2635_1-2-3_Log_HH_MM_SS.csv 

   From Application 

   From User Input 

The Count value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time value indicates the elapsed time since data logging was started. 

4.7 “Prox” Tab 

The main portion of the screen contains a tab labeled Prox. The controls on this tab control the 

operation of the Proximity function of the TMD2635. 
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Figure 9:  

Prox Tab 

 

 

4.7.1 Prox Controls 

The left side of the Prox tab contains controls to set various Prox settings. 

The PPULSE controls the number of pulses used for each prox cycle. The number of pulses is the 

PPULSE value plus 1 and is displayed immediately to the right of the box. 

The PPULSE_LEN control sets the width of all IR VCSEL pulses within the proximity cycle. Longer 

pulses result in increased proximity range and typically result in less electrical noise generated in the 

analog front end.  This drop-down box works in conjunction with the 16x checkbox to select the actual 

pulse length that is used  The values that can be chosen are 1 µs, 2 µs, 4 µs, 8 µs, 12 µs, 

16 µs, 24 µs, and 32 µs. 

The PGAIN control is a pulldown menu that lets you select the analog gain of the proximity IR sensor. 

The values that can be chosen are 1x, 2x, 4x and 8x. 

The PLDRIVE control sets the drive strength of the IR VCSEL current. The values range 2 mA to 

10 mA.  

Checking the PWEN control enables the Prox Wait feature which inserts a wait time between each 

prox cycle.  If this box is not checked, PWLONG and PWTIME have no effect. 

The PWLONG checkbox, when checked, causes any prox wait time to be increased by 12x. 

The PWTIME control controls the amount of wait time that is inserted between prox cycles when prox 

wait is enabled.  The normal wait times range from 2.778 ms to nearly 712 ms.  When PWLONG is 
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checked, the times range from 33.3 ms to over 8.5 seconds.  The actual wait time selected is 

displayed immediately to the right of the box. 

The PDSELECT pulldown menu selects which photodiode(s) are connected to the prox ADC channel.  

You may select None, Far (the photodiode farthest from the VCSEL), Near (the photodiode nearest to 

the VCSEL), or Both. 

The APC Disable checkbox disables the Automatic pulse control feature.  In normal conditions, 

TMD2635 will dynamically reduce the number of pulses specified in the PPULSE control to keep the 

prox data from saturating.  In high crosstalk situations this feature can be disabled, to force the 

specified number of pulses.  When APC is disabled, the range of the prox output data is limited to a 

maximum of 1023. 

The PROX_AVG control allows a selected number of prox samples to be averaged together to 

produce a single PDATA value.  You may disable this feature, or select 2, 4, 8, 16, 32, 64, or 128 

samples to be averaged. 

The PRATE control specifies the length of each prox cycle when PROX_AVG is active.  This is not a 

period of time inserted between cycles, like PWTIME, it is a start-to-start time.  If PRATE is less than 

the amount of time specified by PPULSE and PPULSE_LEN, PRATE will not have any effect. The 

amount of time selected can range from 88 µs to approximately 22.5 ms and is displayed immediately 

to the right of the box. 

The program calculates and displays the Prox Cycle Time.  This is the number of prox samples 

averaged multiplied by the PRATE. 

The POFFSET control shifts PDATA to remove crosstalk from the proximity data. The values range 

from -255 to 255. 

The Auto Offset Adjust control, when checked, will decrease the proximity offset register when 

proximity ADC measurement is zero. When this box is checked, manual changing of the POFFSET 

control is disabled and The POFFSET value is read from the device on each update cycle. 

The Cal button, in the Calibration box, triggers the sensor’s proximity offset calibration sequence. This 

function automatically selects a POFFSET to remove crosstalk from PDATA. 

The Average checkbox, in the Calibration box, controls whether the calibration process should also 

average the number of samples specified by the PROX_AVG control. 

Checking the PRATE checkbox, in the Calibration box, causes the calibration prox cycles to be 

executed at the speed specified by the PRATE control described above. 

4.7.2 Prox Data Plot 

The remaining portion of the Prox tab is used to display a running plot of the collected PDATA values 

and/or the calculated average of the most recent 32 PDATA values. The last 350 values are collected 

and plotted on the graph. As additional values are added, the old values will be deleted from the left 

side of the graph. To start the plotting function, check the Enable Plot checkbox. 
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Figure 10:  

Prox Plot Data 

 

 

Check the Prox or ProxAvg boxes to select the value(s) to be displayed. 

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down arrows at the 

top left corner of the plot. The scale can be set to any power of 2 from 16 to 16384. 

Click the Clear Plot button to discard the current data and continue plotting the new data. Note if the 

Clear Plot button is clicked while the plot is disabled, the data is discarded, but the actual plot will not 

be updated until the plot function is re-enabled. 
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5 Resources 

For additional information regarding the TMD2635, please refer to the datasheet. For information 

regarding the installation of the TMD2635 EVM host application software please refer to the TMD2635 

EVM Quick Start Guide. 

Designer’s Notebooks dealing with various aspects of optical measurement and optical measurement 

applications are available. 

Additional Resources: 

● TMD2635 Datasheet 

● TMD2635 EVM Quick Start Guide (QSG) 

● TMD2635 EVM User’s Guide (this document) 

● TMD2635 EVM Schematic Layout 
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6 Revision Information 

 

Changes from previous version to current revision v1-00 Page 

Initial Release All 

  

  

  

  

  

  

 
● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal Information 

Copyrights & Disclaimer 

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. 
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the 
copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and 
evaluation purposes only and are not considered to be finished end-products intended and fit for general consumer use, 
commercial applications and applications with special requirements such as but not limited to medical equipment or automotive 
applications. Demo Kits, Evaluation Kits and Reference Designs have not been tested for compliance with electromagnetic 
compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation Kits and Reference Designs 
shall be used by qualified personnel only. 

ams AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time 
and without notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a 
particular purpose are disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or 
consequential damages arising from the inadequacy of the provided Demo Kits, Evaluation Kits and Reference Designs or 
incurred losses of any kind (e.g. loss of use, data or profits or business interruption however caused) as a consequence of their 
use are excluded. 

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property 
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any 
kind, in connection with or arising out of the furnishing, performance or use of the technical data herein. No obligation or liability 
to recipient or any third party shall arise or flow out of ams AG rendering of technical or other services. 

 

  

RoHS Compliant & ams Green Statement 

RoHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our 

semiconductor products do not contain any chemicals for all 6 substance categories, including the requirement that lead not 
exceed 0.1% by weight in homogeneous materials. Where designed to be soldered at high temperatures, RoHS compliant 
products are suitable for use in specified lead-free processes.  

ams Green (RoHS compliant and no Sb/Br): ams Green defines that in addition to RoHS compliance, our products are free of 
Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material). 

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that 
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or 
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG 
has taken and continues to take reasonable steps to provide representative and accurate information but may not have 
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers 
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for 
release. 

 

  

 

Headquarters 

ams AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at www.ams.com 

Buy our products or get free samples online at www.ams.com/Products 

Technical Support is available at www.ams.com/Technical-Support 

Provide feedback about this document at www.ams.com/Document-Feedback 

For sales offices, distributors and representatives go to www.ams.com/Contact 

For further information and requests, e-mail us at ams_sales@ams.com 
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Mouser Electronics
  

Authorized Distributor
 
  

Click to View Pricing, Inventory, Delivery & Lifecycle Information:
 
 
 
 ams:   

  TMD2635-EVM  TMD2635-DB

https://www.mouser.com/ams
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